Thank you for purchasing our product.
This manual provides explanations of the installation and operation of the MCR-4TC.
Please make sure the following items are included in the package.

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCR-4TC x 1 unit</td>
<td>1</td>
</tr>
<tr>
<td>“MCR for Windows” CD-ROM x 1</td>
<td></td>
</tr>
<tr>
<td>USB Communication Cable US-15C x 1</td>
<td></td>
</tr>
<tr>
<td>AA Alkaline Battery (LR6) x 2</td>
<td></td>
</tr>
<tr>
<td>User's Manual Set (Warranty Included)</td>
<td></td>
</tr>
<tr>
<td>Card Slot Cover x 1</td>
<td></td>
</tr>
</tbody>
</table>
Important Notices and Disclaimers

In order to properly use this product, please carefully read all documents that accompany the product before using. T&D Corporation accepts no responsibility for any malfunction of and/or trouble with this product or with your computer that is caused by the improper handling of this product and will deem such trouble or malfunction as falling outside the conditions for free repair outlined in the attached warranty.

- All rights of the attached documents belong to T&D Corporation. It is prohibited to use, duplicate and/or arrange a part or whole of the attached documents without the permission of T&D Corporation.

- Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries.

- Windows Vista is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.

- All registered trademarks, company names, product names and logos mentioned herein or for products being used are the property of T&D Corporation or of their respective owners.

- Specifications, design and other contents outlined in the attached documents are subject to change without notice.

- Please follow the safety precautions outlined in the attached documents carefully. We cannot guarantee nor are we responsible for safety if this product is used in any manner other than was intended.

- On-screen messages in the attached documents may vary slightly from the actual messages.

- Please notify the shop where you purchased this product or T&D Corporation of any mistakes, errors or unclear explanations in the attached documents.

- T&D Corporation accepts no responsibility for any damage or loss of income caused by the use of our product.

- Accompanying documents cannot be reissued, so please keep them in a safe place.

- Please read the warranty and provisions for free repair carefully.
Safety Precautions and Instructions

The following items should be strictly obeyed for the safe usage of this product, and for protecting yourself and other people from bodily harm and/or damage to property.

Explanation of Symbols

Warning Symbols

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="DANGER" /></td>
<td>Failure to follow the instructions with this symbol could cause serious injury or even death.</td>
</tr>
<tr>
<td><img src="image" alt="CAUTION" /></td>
<td>Failure to follow the instructions with this symbol could cause personal injury or physical damage to equipment.</td>
</tr>
</tbody>
</table>

Picture Symbols

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Denotes an important warning or caution.</td>
</tr>
<tr>
<td><img src="image" alt="Ban" /></td>
<td>Denotes a forbidden action.</td>
</tr>
<tr>
<td><img src="image" alt="Action" /></td>
<td>Denotes an action that should be carried out.</td>
</tr>
</tbody>
</table>
DANGER To Prevent Serious Accidents

Do not disassemble, repair or modify the unit and accessories.

Do not use the unit in any environment that is exposed to chemicals and harmful gases. Doing so may cause corrosion and/or other danger to the unit. Also, coming in contact with hazardous substances may cause bodily harm to the user or people nearby.

This unit is not water resistant. If water or a foreign object enters the case, immediately unplug the AC adaptor and stop using it.

Do not handle the unit, remove batteries or cables with wet hands.

This product has been designed for private and/or industrial use only. It should not be used in situations where strict safety precautions are necessary such as with medical equipment, or in systems directly or indirectly connected with human life or well-being.

Do not drop or expose the unit to a strong impact.

Do not cut or process the cords for the communication cables. Also, do not twist, pull on or swing any of the cords.

To prevent damage to the unit from static electricity, remove static electricity from your body by touching metal around you (such as a door knob and window frame) before touching the unit.

Place and store the unit and accessories out of the reach of children.

Do not use any power, battery, sensor, or cable other than those specified by T&D Corporation.
We are not responsible for any damage, malfunction or trouble, whether direct or indirect, caused by the use of our product.

Do not put anything on top of the cable. This may cause overheating.

Do not disconnect the USB cable during USB communication. Doing so may cause adverse effects to the unit and/or PC.

Make sure that all cable plugs are inserted fully, so as not to cause an improper connection. Also, when unplugging the cable from the unit, do not pull the cord, but hold the connector to disconnect.

If the unit produces heat, emits smoke or a strange smell, or makes unusual noises, immediately remove the batteries, unplug the power, and stop using it. Also, unplug the unit from the PC.

If the unit is not to be used for a long period of time, remove batteries. If left in the unit, the batteries may leak and lead to malfunctioning. Install new batteries when starting or re-starting to use a unit.

Make sure that there is no magnetic media or materials within one meter from the device. Magnetic materials may cause damage to data stored in magnetic media.

Do not remove the SD card or turn off the power while writing data to the SD card. This may result in damage to data.
CAUTION Do not place or store in the following areas:

- Areas exposed to direct sunlight
- Areas exposed to excessive heat or high temperatures such as near fire or heating equipment
- Areas exposed to static electricity
- Areas exposed to strong magnetic fields
- Areas exposed to dampness
- Areas subject to condensation or wet areas
- Areas exposed to excessive vibration
- Areas exposed to excessive smoke, dust or dirt.

CAUTION Other Precautions

- Use the unit in the specified operating environment. Do not use it for any purpose other than for which it was designed.
- Condensation may occur inside the case when a unit is moved from one environment to another where there is a great difference in temperature.
- Do not use the unit in wet areas or places exposed to water such as bathroom.
- When connecting the unit to your PC, make sure to follow all warnings and directions from your computer manufacturer.
- We shall not guarantee the unit's operation if it has been connected to a PC using a USB hub or a USB extension cable.
- Please take extra caution when plugging in and pulling out the USB plug while another USB device such as CDD or HDD is in operation.
- Do not insert any foreign objects into any of the units' jacks.
- If the unit gets dirty, wipe it with a clean cloth.
- Make sure to remove dust and dirt from plugs of any cables.
- Battery terminals may provide insufficient contact due to age or vibration. This may lead to data loss.
- If the unit is not to be used for a long period of time, for safety reasons please remove the battery. If left in the unit, the battery may leak and lead to malfunctioning.
- When an SD card is not inserted, insert the supplied card slot cover to prevent the intrusion of dust.
Before Using this Product

Please be careful about the procedures for Installation. (For USB communication between your computer and a MCR-4TC)

In order to use a USB connection to communicate between the unit and a computer, it is necessary to install the software and the USB device driver.

Make sure to first install the software and the USB device driver before connecting the unit to a computer. If you connect the unit first, the USB device driver may not be installed properly.

If you have connected the unit to your computer before installing the USB device driver, make sure to click [Cancel] in the Wizard window when it pops up on the computer display. Then disconnect the USB communication cable from the unit.

See p.56 for more information about the USB driver installation (Windows XP).
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Precautions and Instructions</td>
<td>1</td>
</tr>
<tr>
<td>Before Using this Product</td>
<td>5</td>
</tr>
<tr>
<td><strong>Overview</strong></td>
<td></td>
</tr>
<tr>
<td>Appearance Diagram and Part Names</td>
<td>9</td>
</tr>
<tr>
<td>Explanation of Buttons</td>
<td>10</td>
</tr>
<tr>
<td>Touch Panel Operation Methods</td>
<td>11</td>
</tr>
<tr>
<td>LCD Display and Icons</td>
<td>12</td>
</tr>
<tr>
<td>About How Data is Recorded</td>
<td>14</td>
</tr>
<tr>
<td>Using SD Memory Cards</td>
<td>15</td>
</tr>
<tr>
<td>Supported Memory Cards</td>
<td>15</td>
</tr>
<tr>
<td><strong>Using MCR-4TC</strong></td>
<td></td>
</tr>
<tr>
<td>Installing the Battery</td>
<td>17</td>
</tr>
<tr>
<td>Usable Power Sources</td>
<td>17</td>
</tr>
<tr>
<td>Changing the Batteries</td>
<td>17</td>
</tr>
<tr>
<td>Measuring Temperature</td>
<td>18</td>
</tr>
<tr>
<td>About the Measurements Display</td>
<td>19</td>
</tr>
<tr>
<td>About the Trend Graph Display</td>
<td>19</td>
</tr>
<tr>
<td>Operating the Trend Graph</td>
<td>20</td>
</tr>
<tr>
<td>Increasing Recording Channels</td>
<td>21</td>
</tr>
<tr>
<td>Storage Location for Group Recording</td>
<td>22</td>
</tr>
<tr>
<td>Group Operations via Master</td>
<td>23</td>
</tr>
<tr>
<td>Starting Recording by Group</td>
<td>24</td>
</tr>
<tr>
<td>Stopping Recording by Group</td>
<td>24</td>
</tr>
<tr>
<td><strong>About Menus</strong></td>
<td></td>
</tr>
<tr>
<td>[Recording Settings] Menu</td>
<td>26</td>
</tr>
<tr>
<td>[Data List] Menu</td>
<td>28</td>
</tr>
<tr>
<td>Displayed Items when Recording Stopped:</td>
<td>28</td>
</tr>
<tr>
<td>Displayed Items during Endless Recording:</td>
<td>29</td>
</tr>
<tr>
<td>[Memory Card] Menu</td>
<td>30</td>
</tr>
<tr>
<td>[Operation Settings] Menu</td>
<td>31</td>
</tr>
</tbody>
</table>
# Overview

<table>
<thead>
<tr>
<th>Explanation of Items in Each Menu</th>
<th>32</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Record Settings] Menu Items</td>
<td>32</td>
</tr>
<tr>
<td>[Data List] Menu Items (when recording stopped)</td>
<td>34</td>
</tr>
<tr>
<td>How to Read Graphs of Recorded Data</td>
<td>36</td>
</tr>
<tr>
<td>[Data List] Menu Items (during endless recording)</td>
<td>38</td>
</tr>
<tr>
<td>Canceling [Auto Data Export]</td>
<td>39</td>
</tr>
<tr>
<td>[Memory Card] Menu Items</td>
<td>40</td>
</tr>
<tr>
<td>[Operation Settings] Menu Items</td>
<td>41</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Using a PC with MCR-4TC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing the Supplied Software</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connecting the Device to a PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>46</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Making Settings via PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>47</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Channel Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>47</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Downloading Recorded Data to a PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Download Recorded Data using “MCR for Windows”</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recorded Data File</th>
</tr>
</thead>
<tbody>
<tr>
<td>49</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Download Recorded Data from all Connected MCR-4TC Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Analyzing Recorded Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Open Recorded Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print Graphs</th>
</tr>
</thead>
<tbody>
<tr>
<td>51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Other</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>52</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>How to Install the USB Driver (Windows XP)</th>
</tr>
</thead>
<tbody>
<tr>
<td>56</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>57</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MCR-4TC</th>
</tr>
</thead>
<tbody>
<tr>
<td>57</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software (MCR for Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>59</td>
</tr>
</tbody>
</table>
Overview

The MCR-4TC Multichannel Temperature Recorder is designed to measure a wide range of temperatures using a thermocouple sensor. After it measures and records temperature, the data can be easily displayed in graph form, enabling the immediate on-the-spot checking of continually-changing data.

Measure and Record

Use “MCR for Windows” for
Device Settings
Recording Settings
Downloading Recorded Data

Use “T&D Graph” for
Graph Display
Data Analysis
Printing and Saving in Text

Main Features in Rec Settings
Recording Mode
Recording Method
Recording Interval
Recording Channel

Measurements
and Trend Graph

SD Memory Card
or
USB Connection

Coupling Image

Master
Slaves

Throughout this manual, the MCR-4TC is also referred to as “the device” or “the unit”.

8
Appearance Diagram and Part Names

1. Input Terminal
2. Coupling Lug
3. LCD Display
4. Touch Panel (touchpad and control wheel)
5. SD Memory Card Slot
6. USB Port
7. Battery Cover
Explanation of Buttons

Press to change the selected menu or settings item (by going up or down), and to increase or decrease the values shown in the LCD.

Press to confirm the selected menu, operation, or value.

Press to jump to the [Start Recording] or [Stop Recording] menu.*

Press to return to the previous screen in the menu or cancel the current operation.*

Press and hold to turn the power ON/OFF.

Press to switch the display between [Menu] - [Measurements] - [Trend Graph].

Press to switch between the touchpad operation and control wheel operation. Press and hold to switch the key lock ON/OFF.

* Will not function when operating by control wheel.
Touch Panel Operation Methods

There are two ways to operate the touch panel as follows:

- Touchpad operation
- Control wheel operation

Terms and gestures related to operations

Tap (touch)
Tap desired area of touch panel.

Press-and-hold (hold down)
Touch the screen and hold finger in place for a few seconds. Mainly used to switch ON/OFF the power and key lock.

Control Wheel Operation (rotate)
Press and rotate the control wheel (white circular area). Clockwise movement moves ▲ (up) and counterclockwise movement moves ▼(down).

IMPORTANT
- During operation, if none of the above gestures are performed for a while, the operation will be canceled and the screen will return to the original value or previous screen.

- Make sure to use a bare finger to operate the touch panel. If you use the tip of your fingernail, gloves, or touch pen, touch panel operations may not be recognized.

Auto Power Off Function
If the device is not used for about three minutes, it will automatically turn off to save battery power. However, the Auto Power Off function will be disabled in any of the following situations.

- When a recording session is in progress
- When measurements or trend graphs are displayed on the screen
- When running on external power
**LCD Display and Icons**

The following contains some brief explanations about icons. Each menu will be explained later in the “Menu List” pages.

- **1 Recording Status**
  - Shows the recording status.
  - REC: Recording in progress
  - STP: Recording stopped
  - PRG: Waiting for programmed start
  - IMM: Preparing immediate start

- **2 Recording Mode**
  - Shows the recording mode.
  - Endless mode
  - One-Time mode

- **3 Recording Interval**
  - Shows the recording interval.
  - ms: millisecond(s)
  - sec: second(s)
  - min: minute(s)
  - When the recording method is Average, “Aver.” and the recording interval are displayed alternatingly.

- **4 Recording Channel**
  - Shows the channel(s) being measured and recorded.

- **5 Battery Mark**
  - Shows source of power and battery level
  - Battery Mark (Alternating Display): Running on external power
  - Battery Mark only (see the next page): Running on battery

- **6 Operation Mode**
  - Shows the operation mode status.
  - Touchpad operation enabled
  - Control wheel operation enabled
  - Touch Panel disabled
These indicate that there are more menu items above or below for view. Use ▲ and ▼ on the touch panel to scroll up and down.

An item marked with an arrow denotes it has been selected. Use ▲ and ▼ on the touch panel to move the arrow up and down. Press <ENTER> to execute the selected operation.

A highlighted display shows the item currently selected, and a blinking highlight shows that an item is being changed.

The battery mark shows the battery level as follows.

- **FULL**: Full or near full power
- **▌**: Beginning to lose power
- **▋**: Significant loss of power
- **▊**: Change batteries as soon as possible
- **▉**: Change batteries immediately
- **▕**: Not operable with batteries only

Below are some examples of recording conditions and the corresponding estimated battery life.

<table>
<thead>
<tr>
<th>Recording Conditions</th>
<th>Estimated Battery Life</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 channels, Instantaneous value, 500-ms interval</td>
<td>About 7 days</td>
</tr>
<tr>
<td>4 channels, Instantaneous value, 1-sec interval</td>
<td>About 21 days</td>
</tr>
<tr>
<td>4 channels, Instantaneous value, 5-sec (or longer) interval</td>
<td>About 60 days</td>
</tr>
</tbody>
</table>

* Battery life varies depending upon the ambient temperature in which it is used, the recording interval, the number of channels, and the frequency of data export to a memory card.
About How Data is Recorded

The MCR-4TC records measurement data to its internal memory. A recording session is one cycle from recording start to stop, and the MCR-4TC can record multiple sessions. The number of recording sessions and number of data readings which can be recorded depends upon the number of channels, the recording interval and other settings. In the “n”th recording session, the remaining memory space is used for recording.

**EX: When logging capacity is filled during the 5th recording session:**

In Endless mode, data will be overwritten from the beginning of the 5th recording session and recording will continue.

In One-Time mode, recording will stop.

* If the memory capacity has not reached full, up to 30 recording sessions can be made.
Using SD Memory Cards

It is not only possible to transfer data stored in the internal memory to an SD memory card, but it is also possible to automatically backup data while recording in endless mode. Operations related to the use of an SD memory card are as follows:

Exporting Data while Recording is OFF (Manual Saving) See p.34 for details
→ [Data List] — [Export Selctd Data]
→ [Data List] — [Export All Data]

Exporting Data while Endless Recording is ON (Manual Saving / Automatic Saving) See p.38 for details
→ [Data List] — [Expt Curr Data Now]
→ [Data List] — [Auto Data Export]

IMPORTANT
- Memory cards are not included. Please purchase separately.
- Measurement data cannot be directly recorded into a memory card.
- Before inserting an SD memory card into the device, make sure to switch off write protection on the memory card.
- Exporting data to the memory card will not erase it from the device’s internal memory. Delete recorded data in the device as necessary.

Supported Memory Cards
- SD Memory Cards
- SDHC Memory Cards

IMPORTANT
- SDXC memory cards cannot be used.
- It is possible to run a quick test to see if your memory card works in MCR-4TC. See p.40 for details.
Using MCR-4TC

The following shows the basic flow of procedures.

1. Getting Ready
   Install the batteries (see p.17)

2. Getting PC Ready
   Install the provided software (see p.44)
   Connect the device to a PC (see p.46)

3. Setting up the Device (see p.31) / Making Recording Settings (see p.26)
   * Recording Settings can be made both on the device and from a PC.

4. Measuring and Recording

5. Viewing Recorded Data in Graph on the Device (see p.36)

6. Downloading Recorded Data to a PC
   Exporting data to an SD memory card for transferring to a PC (see p.34)
   Using the supplied software “MCR for Windows” (see p.48)
   * Either of the above can be used to download recorded data to a PC.

7. Analyzing Recorded Data on a PC (see p.51)
   View Graph, Print, Save in Text

When not using a PC, the only necessary steps are 1 and 3 to 5.
Installing the Battery

Remove the battery cover from the back of the device, and insert the supplied two AA alkaline batteries as shown in the figure below. After the batteries are inserted, the [Please set the clock] message will appear on the LCD.

* For information on how to set the clock, see p.41.

**IMPORTANT**
- Make sure to use new batteries of the same kind.
- Make sure not to mistake + / -.
- Do not insert or change batteries with wet hands.
- Be sure to completely close the cover.
- The MCR-4TC cannot recharge batteries.

Usable Power Sources
- AA Alkaline Batteries
- AA Ni-MH Batteries
- AC Adapter (USB type)
- USB Bus Power

Changing the Batteries

If the battery runs down before it is replaced, MCR-4TC will automatically stop recording to protect data. Check the battery mark (see the previous page) and change batteries as necessary.

**IMPORTANT**
- To protect data, please stop recording first before changing batteries. Not doing so may result in loss of data being recorded.
- When you wish to replace batteries while recording is in progress, make sure to connect the USB cable to your PC for USB bus power.
- If the MCR-4TC runs out of power while processing data on a SD memory card, the data on the card may be corrupted.
Measuring Temperature

1. Connect the thermocouple wire or thermocouple extension lead wire to the proper terminals of the MCR-4TC.

1. Prepare a single wire of Ø0.32mm to Ø0.65mm (AWG 28-22), or a twisted wire of 0.08mm² to 0.32mm² (AWG 28-22) with a diameter of 0.12mm or more. Strip about 10mm from its end.

2. Using a screwdriver or other such tool, while pressing down on the input terminal button <B> on the top of the device, insert the wire into the hole <A>.

   * Thermocouples have polarity; make sure to connect in the right way to get a proper reading. If the polarity is incorrect, changes in temperature will be reversed (when the real temperature increases, the measured temperature will decrease).

3. When removing the wire, push down on <B> and gently pull the wire out of the hole <A>.

   * MCR-4TC supports the following thermocouple types: K, R, S, T, and J.
   * Temperature can only be measured within the heat-durability range of the sensor being used.

2. Press <DISPLAY> to switch to the graph display, and view the measurements in a trend graph.
About the Measurements Display

The font size used to display the measurements automatically changes depending on the number of channels.

* You can change the number of channels by going to the Main Menu and selecting [Record Settings] > [Rec.Channel].

About the Trend Graph Display

A trend graph is displayed for each channel of data.

1. Channel for Display
   The channel for display can be changed. Select the measurement channel to view the graph.

2. Scrolling Method
   
   LEFT: Scrolls graph and divisions together.
   
   RIGHT: Scrolls graph only.
   
   * The scrolling method can be switched with <ENTER> when none of 1 to 4 are highlighted or flashing on the LCD.

3. Vertical Axis Scale (max/min)
   Specify the range of the vertical axis to be displayed in the graph. The max and min values can be set in units of 100°C in a range of -300°C to 1800°C.

   EX) “V.AXIS -100, 500” shows that the displayed range of the vertical axis is from -100 to 500°C.

4. Horizontal Time Scale (time/div)
   Specify the value for each horizontal division in sec or min.

   EX) “H.Axis 1s/div” shows that each horizontal division represents 1 sec.

   * The possible selections for the time scale will change depending on the measurement interval.
Operating the Trend Graph

Use ▲ and ▼ to highlight the desired item, and tap <ENTER>. While the selected item is blinking, use ▲ and ▼ again to change the value, and tap <ENTER>.

* If no operations are performed or a change is not confirmed with <ENTER> while the selected item is blinking, the operation will be canceled and the selected item will return to the original value.
Increasing Recording Channels

Up to four units can be coupled together to allow for a maximum of 16 channels.

When the bodies of multiple units are connected, the MCR-4TC at the far left side will be automatically designated as the Master and all other connected MCR-4TC units will be designated as Slaves. By starting recording on the Master unit, all connected Slave units will start recording at the same time.

**Coupling Image**

Coupling of MCR-4TC and MCR-4V is possible. Refer to the MCR-4V User's Manual for its operating instructions.

**IMPORTANT**

When using MCR-4V as the Master and MCR-4TC as the Slave, Group Recording cannot be started if the measurement interval of the Master is less than 100ms.
Storage Location for Group Recording

When performing a group recording for multiple units, recorded data will be stored in each unit’s memory. To analyze recorded data on a PC, either download data using “MCR for Windows”, or export data to the SD memory card to transfer to a PC.

“MCR for Windows” also makes it possible to download recorded data from Master and all Slave units together.

* All recorded data files downloaded using “MCR for Windows” will be stored in the same folder by default. See p.49 for the storage location of recorded data and file name.
Group Operations via Master

Group operations such as the starting and stopping recording for the connected units can only be performed via the Master. Upon the start of a group recording, the main recording settings will be temporarily copied to all connected Slaves. Upon the stopping of recording all copied settings will be returned to their original state.

Using “MCR for Windows”, it is possible to start and stop recording by group by connecting the Master to a PC via USB.

**Settings Controlled by the Master:**
Settings for Recording Mode, Recording Method, Recording Interval, and Recording Channels

**Settings not Controlled by the Master:**
Channel Name and Thermocouple Type

**IMPORTANT**

- Operations related to the SD memory card (such as Quick Format and Memory Card Test) cannot be performed by group via the Master.

- To change the Thermocouple Type, either change directly on the target connected Slave unit, or use “MCR for Windows” and connect each Slave unit to the PC with a USB cable.

- The Channel Name can only be set or changed via “MCR for Windows”.

Starting Recording by Group

1. Make recording settings for each device separately; no matter if it is a Master or a Slave.
   * See p.26-27 for a list of the possible setting items.
   * See p.23 for the settings that are/are not controlled by the Master.

2. From the main menu of the Master, select [Record Settings] - [Start Recording].

3. For the [Method], select [IMMED(grp) or [PGM(grp)].

4. Select [OK] and tap <ENTER>.

**IMPORTANT**
All connected Slaves need to have power switched to ON.

Stopping Recording by Group

From the main menu of the Master, select [Record Settings] - [Stop Recording].

**IMPORTANT**
- During Group Recording, if the bodies of the devices are disconnected from one another, recording will continue on the Master but will stop on the Slave units.
- Even when devices are coupled, power will not be supplied from the Master to any connected Slave units.
- When the Master stops recording, all Slaves will stop recording.
- During recording in one-time mode, if the Slave's memory capacity becomes full, recording will stop on that Slave unit.
About Menus

[Recording Settings] Menu

- Stop Recording
  - OK

- Start Recording
  - OK
  - Method: IMMED(indv)

Rec.Mode: Endless / One Time
Rec.Method: Instant / Average
Rec.Interval: 10 sec / 100 / 200 / 500ms / 1 / 2 / 5 / 10 / 15 / 20 / 30sec / 1 / 2 / 5 / 10 / 15 / 20 / 30 / 60min
Rec.Channel: CH1234 / CH1 / CH2 / CH3 / CH4 / CH12 / CH23 / CH34 / CH13 / CH24 / CH14 / CH123 / CH234 / CH124 / CH134 / CH1234

CH1 T.C. Type: K / R / S / T / J
CH2 T.C. Type
CH3 T.C. Type
CH4 T.C. Type
*1: Will only appear when the recording start method is set to PGM (programmed start).
[Data List] Menu

Displayed Items when Recording Stopped:

- **[Back]**

- **Display Graph**
  - * List number, date, and time shown below are examples.
  - [Back]
  - No4  Jul 30 '13 16:19:45
  - No3  Jul 29 '13 15:42:51
  - ...

- **Export Selctd Data**
  - [Back]
  - No4  Jul 30 '13 16:19:45
  - No3  Jul 29 '13 15:42:51
  - ...

- **Export All Data**
  - [Back]
  - OK

- **Delete Selctd Data**
  - [Back]
  - No4  Jul 30 '13 16:19:45
  - No3  Jul 29 '13 15:42:51
  - ...

- **Delete All Data**
  - [Back]
  - On This Device Only
  - On All Devices*1

*1: When selecting [Delete All Data] on the Slave unit, the [On All Devices] option will not appear.
Displayed Items during Endless Recording:

[Back]
Expt Curr Data Now
Auto Data Export*1

Formatted & Blank Card?
[Back]
Yes
No

Quick Format
[Back]
OK

*1: When recording in one-time mode, [Auto Data Export] will not be displayed.
[Memory Card] Menu

- Quick Format
  - [Back]
  - OK

- Memory Card Test
  - [Back]
  - OK
[Operation Settings] Menu

[Back]
Set Contrast: 65 0 to 100
Check Memory

Set Clock

Memory:
Data:

Nov/07/13 16:43:22
Time Zone GMT+09:00
DST 00:00

Beep: ON ON / OFF All / OFF Click
Key Lock: OFF OFF / 240 to 5 sec.
Unit of Temp: °C °C / °F
Burnout Detect: ON ON / OFF

Return to Default

[Back]
OK
Explanation of Items in Each Menu

[Record Settings] Menu Items

[Stop Recording]
Click [OK] to stop recording.

[Start Recording]
Click [OK] to start recording.

[Method: IMMED(indv) / PGM(indv) / IMMED(grp) / PGM(grp)]
IMMED(indv): Starts recording immediately.
PGM(indv): Starts recording on the specified date and time.
IMMED(grp): Starts Group Recording immediately.
PGM(grp): Starts Group Recording on the specified date and time.
For details about Group Recording, see p.21.

[Recording Mode: Endless / One Time]
Endless: When the internal memory capacity becomes full, the most recent data will be overwritten and recording will continue.
Onetime: Recording will be stopped at the moment the internal memory capacity becomes full.
* See p.14 for an outline of info about recording and memory.

[Rec.Method: Instant / Average]
Select the recording method to be used.
Instant (Value): Records the instantaneous value at the set recording interval.
Average (Value): Records the value as the average of the measurements taken during the set recording interval.
See below for the sampling intervals when recording average values.

<table>
<thead>
<tr>
<th>Recording Interval</th>
<th>100 to 200ms</th>
<th>500ms to 1sec</th>
<th>2sec to 5min</th>
<th>10 to 60min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sampling Interval</td>
<td>100ms</td>
<td>500ms</td>
<td>1min</td>
<td>10min</td>
</tr>
</tbody>
</table>

**IMPORTANT**
When recording average values, the first recorded value is invalid because an average cannot be calculated.
[Rec. Interval: user-specified time]
Select from 18 choices: 100, 200, 500 msec. / 1, 2, 5, 10, 15, 20, 30 sec. / 1, 2, 5, 10, 15, 20, 30, 60 min. (default setting is 10 sec)

**IMPORTANT**
- It is not possible to make different recording interval settings for each channel.

[Rec. Channel: user-specified channel(s)]
Select the channel(s) for recording. It is possible to select to record using one channel or a combination of channels from Ch1 - Ch4.

[CH1 T.C.Type - CH4 T.C.Type]
Select a thermocouple type for each channel: Type K, R, S, T, or J.

[Save/Restore Sett.]
By selecting [Save Settings], it is possible to save up to 4 types of recording settings. All setting items in the [Record Settings] menu can be saved and re-used, allowing you to save steps to repeat making the same settings each time.

To use the saved recording settings (No.1 to 4), open them by selecting [Restore Settings (No.1 to 4)]. [Restore Settings] screen will show a part of the record settings as below.

![Restore Settings Screen](image)

**IMPORTANT**
- Only settings that have been saved from [Save Settings No.1 to 4] are available for restoring.
- While a recording is in progress, recording settings can only be saved, but not restored.
- **ALL** saved settings will be deleted by executing [Return to Default] from the [Operation Settings] menu. It is not possible to delete each saved setting individually.
[Data List] Menu Items (when recording stopped)

[Display Graph]
From the displayed list, select data you wish to view in a graph and tap <ENTER>. See p.36 for details on how to read and control the view of recorded data graphs.

[Export Selctd Data]
From the displayed list, select data to export to the SD memory card and tap <ENTER>.

**IMPORTANT**
Multiple data files cannot be selected for exporting.

[Export All Data]
Select [OK] to export all data to the SD memory card.

[Delete Selctd Data]
⚠️ While “Processing” is displayed on the LCD, do not perform any other operations. This process may take a long time to complete.

Select the data you wish to delete from the displayed list, and tap <ENTER>.

* If no operations are performed for a while on the data list screen, you’ll return to the previous screen.

* Deleting only a few (1-3) data readings from a list which contains a small number of readings may have no effect on memory usage. (see p.41 for how to check memory capacity)

[Delete All Data]
[On This Device Only]:
Select [OK] to delete all recorded data on the device currently in use.

[On All Devices]:
Select [OK] to delete all recorded data on the Master and all connected Slave units all together.

* If you try to perform this operation on a Slave unit, the [Delete All Data] menu will only show the [On This Device Only] option.
How to Read Graphs of Recorded Data

The graph can be scrolled on the display by using ▲▼ or control wheel operation to move to the left or right.

1. While scrolling, the time of recorded data appears on the top of the screen.

2. The time of recorded data will switch to the measurement, a few seconds after you stop scrolling.

3. The measurement shown in 2 is the value of the point located at the center of the graph.

4. The bar on the bottom of the graph shows the portion of the data in the view window.

Tapping <ENTER> allows you to change 5, 6 and 7.

5. Recording Channel

Select the desired channel to view a graph. If the displayed channel has not been used for recording, you will see the “No Record” message.

6. Vertical Axis Scale (max/min)

Specify the range of the vertical axis to be displayed in the graph. The max and min values can be set in units of 100°C in a range of -300°C to 1800°C.

EX) “V.AXIS 0, 100” shows that the displayed range of the vertical axis is from 0 to 100°C.

7. Skimming Level (Horizontal Axis Scale)

Specify the scale of the horizontal axis to be displayed in the graph.

* User selectable skimming level changes depending on the measurement interval.

Use <ENTER> and <BACK> to move to the target item, then change the value with ▲ and ▼.
About Menus

* When changing settings as above, if no operations are performed or a change is not confirmed with <ENTER>, the change will automatically be applied and the graph will return to the “Scroll” mode.
[Data List] Menu Items (during endless recording)

[Expt Curr Data Now]
Use this to immediately export the data currently being recorded to the SD memory card.

**IMPORTANT**
Memory cards are not included. Please purchase separately.

[Auto Data Export]
To prevent data loss in Endless mode, this menu will automatically export the data to be overwritten to the SD memory card.

* When the internal memory capacity becomes full in Endless mode, the most recent data will be overwritten and recording will continue.

⚠️ Make sure to use a formatted blank SD card, or carry out a “Quick Format”.

* During the [Auto Data Export] process, other operations cannot be performed except for switching the LCD display between [Menu] - [Measurements] - [Trend Graph] by pressing DISPLAY.
Canceling [Auto Data Export]

If you wish to cancel the auto data export process, select [Back] and tap <ENTER>.

The displayed message will be cleared when the process is terminated.

Restrictions on [Auto Data Export]
- The exporting process will be terminated when the SD card is removed.
- The process will be terminated when an SD card write error occurs.
- The process will be terminated when recording is stopped.
- USB communication cannot be used until the process has been completed.
- During the process, REC STOP is deactivated and cannot be used to stop recording.
[Memory Card] Menu Items

[Quick Format]
Select [OK] to format your SD memory card for use in the MCR-4TC.

**IMPORTANT**
- This process will erase all recorded data from the SD memory card. It is recommended to make backups of recorded data to a PC before formatting the memory card.
- It is not possible to erase individual data readings from the SD memory card.
- Do not turn off the power while the device and SD memory card are in communication. If the device is running on batteries, make sure the batteries have power and are installed correctly. If power is supplied by a PC over the USB bus, avoid power supply disruption due to cable disconnection or power-saving settings on the PC.

[Memory Card Test]
Select [OK] to check if your SD memory card can be used with the MCR-4TC. Not all commercially available SD memory cards can be used. It is recommended to do this test before using.

**IMPORTANT**
If the memory card you wish to use passes the test but has problems when using, carry out "quick format".
[Operation Settings] Menu Items

[Set Contrast]
Adjust the LCD contrast with ▲ and ▼. Tap <ENTER> to confirm the contrast.

[Check Memory]
You can check the memory usage (% of capacity) and the number of recorded data.

[Set Clock]
1. Tapping ▼ will change the selection item of the display in the order of month, day, year, hour, minute, and second. By tapping <ENTER>, the value for that item will flash.
2. While flashing, use ▲▼ to select the desired value and tap <ENTER> to confirm.
3. Move to the next or previous setting item with ▼ or ▲.
* By tapping <BACK> while the selected item is flashing, the operation will be canceled and flashing will stop.

[Time Zone] and [DST]
Set the time zone according to the region in which the MCR-4TC will be used. Daylight savings time (DST) settings must be set manually.

IMPORTANT
- It is not possible to set the clock while recording is in progress.
- Please make sure that the date and time settings in the MCR-4TC are correct, if they are not, the recording start time and recording time of downloaded data will be incorrect.
- Clock settings (including time zone and DST) for the MCR-4TC can also be made from your computer by using the supplied software “MCR for Windows”. When making settings via the software, it is not necessary to carry out operations from the MCR-4TC. For details, see the Help menu in the software.

[Beep]
This allows you to turn off the operation confirmation beeping sound.
* The “OFF Click” option will turn off the confirmation sound for touch panel operation only.
[Key Lock]
This function automatically disables the use of the touch panel if no operations occur during a set period of time. It helps prevent handling mistakes.
Use ▲▼ to specify the amount of time before the lock sets (in 1-sec units).
* If you wish to turn ON the key lock immediately, press and hold on the touch panel. The lock can be released by pressing and holding again.

[Unit of Temperature]
Select °C or °F.

[Burnout Detect.]
When this function is ON, it will detect thermocouple burnout and the device will display the “ER B.OUT” message on the LCD.

[Return to Default]
By clicking [OK], the device will be initialized by returning it to the factory default settings.

⚠️ This will delete all data stored in the device and initialize the settings. Please be careful when initializing a device as it is not possible, after initialization, to retrieve previous settings info or recover deleted or corrupted data.

⚠️ Do not turn off the power of the MCR-4TC during initialization. Termination of the initialization process may cause damage or malfunction to the device.
Using a PC with MCR-4TC

By using the supplied software, it is possible to make Device Settings and Recording Settings from a computer, as well as download recorded data from the MCR-4TC to your computer for graph view and data analysis.

Installing the Supplied Software

The software installation procedure is as follows:

1. Start Windows and login using a User Account with Administrator (Computer Administration) rights.
2. Place the CD-ROM into your CD or DVD drive.
3. The [Install Program] window will appear.

   If the [Auto Play] window appears:
   Click on [Run start.exe].

   If the [Install Program] window does not appear automatically:
   Double click on the [start.exe] icon in the CD/DVD drive.

* If you are using Windows 8, carry out the rest of the installation process on the “desktop” which can be accessed via a tile on the Start screen.
4. Select “Install “MCR for Windows” and click [Execute] to start the installation.
5. Follow the directions as they appear to complete the installation.

* If a window appears such as the one below during installation, click [Install] or [Continue Anyway].

After installation, “MCR for Windows” will appear in the Windows Start Screen or Start Menu.

6. To view recorded data in a graph or print out, go back to step 4 and install “T&D Graph”.

* For details about operations please see the “Help” menu in the software.
Connecting the Device to a PC

1. Open “MCR for Windows” from the Start Screen or Start Menu.

2. Connect the device with the supplied USB cable to your computer. The USB driver installation will start automatically.

**IMPORTANT**
- Make sure to install the supplied software “MCR for Windows” before connecting the MCR-4TC to the computer.
- The USB device driver must be installed before trying to carry out USB communication. After installing the USB device driver, your computer will be able to detect and recognize any MCR-4TC unit that is connected with a USB communication cable.
- When connecting a MCR-4TC to a PC, connect only one unit at a time. If you connect multiple units at the same time, they may not be recognized properly.

**IMPORTANT**
- If you are using Windows XP, the “Found New Hardware Wizard” window will open when the device is detected. Follow the instructions on p.56 and install the USB device driver.
- For the installation procedure of the software “MCR for Windows”, see p.44.

When the USB driver installation completes, on the upper right corner of the software screen, you will see an icon showing the PC and MCR-4TC connected via USB.

**IMPORTANT**
If you don't see this icon, the USB driver may not have been installed correctly. Please see [Help for Unit Recognition Failure] in the Help menu, and check the USB driver.
Making Settings via PC

The following items are not included on the device menu, and can only be set or changed from “MCR for Windows” by connecting the device to a computer via USB.

Channel Name

Create and assign names to each of the channels to be used for recording. Channel Names are used for display in “T&D Graph”.

1. In “MCR for Windows”, select the [Recording Start Settings] menu.
2. Place a check next to the desired channel(s) and enter each channel name.
3. Click [Send Settings].
Data stored in the internal memory of MCR-4TC can be downloaded to a computer in either of the following two ways:

- Use an SD memory card to export recorded data and transfer to a PC.*
- Use “MCR for Windows” to download by connecting the device to a PC.

* For how to export recorded data to an SD memory card, see p.34.

**IMPORTANT**
When recording is in progress, there are restrictions on functions related to the SD memory card.

**Download Recorded Data using “MCR for Windows”**

By connecting the device to a PC with a USB communication cable, it is possible to download recorded data to a PC.

1. Open “MCR for Windows”.
2. Connect the device to your computer.
4. Check the desired data in the list.
Using a PC with MCR-4TC

5. Click [Download].

Recorded Data File

One recorded data file (.r4T) is created for each recording session.

Storage Location of Recorded Data and File Name

The default setting is as follows.

Storage Folder:

C:\Users\username\Documents(or My Documents)\TandD Corp\MCR

File Name:

Serial number_rec.month_rec.day_rec.year_rec.time (hhmmss).r4T

To change the default storage folder, click ① and specify the desired folder. Button ② allows you to specify the desired file name as well as its location.
Download Recorded Data from all Connected MCR-4TC Units

1. Connect the Master unit to your computer via USB.
2. Get a data list for the Master. (see p.48)
3. Click [Search for Slave] to get data lists for the connected Slave units.
4. Place a check next to the target data.
   * It is possible to select data from both the Master and Slave unit(s) for simultaneous download.
5. Click [Download].
   * If it takes too long to download data recorded from Slave units, it is also possible to directly connect a Slave to the PC via USB and download individually. (You can switch the USB cable from the Master to connect a Slave.)

**IMPORTANT**
*Do not disconnect the USB cable during communication between a device and the PC.*
Analyzing Recorded Data

Open Recorded Data
In the storage folder for the downloaded recorded data on your PC (p.48), double click on the desired recorded data file. “T&D Graph” will be opened and a graph displayed.

Print Graphs

1. Open recorded data from the “T&D Graph”.

2. Make any desired adjustments to the window size and aspect ratio to be reflected in the printed graph.

3. In the [File] menu, select [Print Graph] to view the preview image of the printed page. If necessary, go back to step 2 and change the aspect ratio again.

4. To start printing, select [Print].

“T&D Graph” also enables you to:
- Insert memos, comments, and shapes on the graph
- Merge and filter recorded data
- Copy graphs
- Display data as a list
- Export the graph as text data (in CSV format)

* Refer to Help in “T&D Graph” for details about operations and procedures.
Troubleshooting

**Q1.** The computer does not seem to recognize the MCR-4TC, why not?

**A1.** Please check the following:

**Check the MCR-4TC**

Check the USB connection between the computer and the MCR-4TC.

**Check the Computer**

- Make sure that the software has been installed properly and is working.
- The USB driver installation may not have been installed correctly. Please see [Help for Unit Recognition Failure] in the Help menu, and check the USB driver.
- Connect a different USB device (mouse, digital camera, etc...) other than the MCR-4TC to your computer and see if it operates properly.
- If your computer has more than one USB port, try connecting the USB cable to a different port.
- If you have access to another computer, try seeing if communication works with the other computer.

If after checking and trying the above there is no improvement please contact the distributor where the product was purchased.

**Q2.** The first reading of recorded data is invalid data, why?

**A2.** One of two scenarios is possible:

- When recording average values, the first recorded value is invalid because an average cannot be calculated.
- In Group Recording with MCR-4V as the Master, when the Preheat function has been set to ON (recording method: instantaneous values only) and the preheat time is set to longer than the waiting time before recording start, the first data reading will be invalid because preheating has not been completed.
Q3. Is it possible to change the batteries while the unit is in operation?
A3. If the unit is connected to an AC adaptor or some other external power source, it is possible to change the batteries. If only batteries are being used as the power source, it is necessary to stop recording before changing the batteries.

Q4. Is it possible to adjust or alter recorded data that has been downloaded by the MCR-4TC?
A4. In order to maintain the integrity and trustworthiness of the recorded data, the software has been designed to not allow modifications to be carried out on actual recorded data. If it is necessary to edit recorded data, in “T&D Graph” save the data to text file and use a common spreadsheet software, such as Excel, to edit the text file data.

Q5. I get a “Write Error” when I try to export recorded data to an SD memory card, what should I do?
A5. Please check the following:
- Make sure the write protection switch on the SD memory card is unlocked.
- Check if your SD memory card is supported by the MCR-4TC. (See p.15)
- Perform a “Memory Card Test”. (See p.40)
- Perform a “Quick Format” for your SD card. (See p.40)
If after checking and trying the above you still get an error message, please contact the distributor where the product was purchased.
Q6. The software “MCR for Windows” does not start, why not?

A6. Please check the following:

- The software may not have been installed correctly. Try reinstalling “MCR for Windows”.
- Check to see if the software was installed with Administrator rights.

(For Windows 7 or earlier:)
- The .NET Framework 4 Client Profile may not have been installed correctly. Follow the steps below to see if the .NET Framework 4 Client Profile has been installed correctly.

In the Control Panel, open [Program and Features] or [Uninstall a Program].

When the .Net Framework 4 Client Profile is not in the list above: Try reinstalling “MCR for Windows”. The .Net Framework 4 Client Profile will be automatically installed with the “MCR for Windows”.
When the .Net Framework 4 Client Profile is in the list above:
Follow the steps below to repair the .Net Framework 4 Client Profile.

1. Select Microsoft .NET Framework 4 Client Profile and click [Uninstall or Change].
2. In the maintenance box, select “Repair .NET Framework 4 Client Profile to its original state” and then click [Next]. Click [Finish] when prompt.

If after checking and trying the above there is no improvement please contact the distributor where the product was purchased.
How to Install the USB Driver (Windows XP)

If you are using Windows XP, the “Found New Hardware Wizard” window will automatically open when a USB device is connected. Please follow the directions to install the USB driver.

1. Check “No, not this time.” and click [Next].

2. Check “Install the software automatically (Recommended)” and click [Next].

3. When the completion message appears, please click [Finish].
## Specifications

### MCR-4TC

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Channels</td>
<td>Temperature 4ch</td>
</tr>
<tr>
<td>Compatible Sensors</td>
<td>Thermocouple: Type K, J, T, S, R</td>
</tr>
<tr>
<td>Measurement Units</td>
<td>°C, °F</td>
</tr>
</tbody>
</table>
| Measurement Range             | Type K: -270 to 1370°C  
Type J: -210 to 1200°C  
Type T: -270 to 400°C  
Type S: -50 to 1760°C  
Type R: -50 to 1760°C                                                                 |
| Input Impedance               | Approx. 1 MΩ                                                                                                                           |
| Accuracy (*1)                 | Thermocouple Measurement  
Type K, J, T: ±(0.5°C + 0.3% reading) [at -100°C or above]  
Type S, R: ±(1.5°C + 0.3% reading) [at 100°C or above]  
(Individual sensor inaccuracies not included.)  
Cold Junction Compensation  
±0.5°C [in operating environment of 10 to 40°C]  
±0.8°C [in other operating environment]                                                                 |
| Measurement Resolution        | 0.1°C                                                                                                                                   |
| Recording Method              | Instantaneous or Average                                                                                                               |
| Recording Interval            | 100, 200, 500 ms.  
1, 2, 5, 10, 15, 20, 30 sec.  
1, 2, 5, 10, 15, 20, 30, 60 min.                                                                 |
| Logging Capacity (*2)          | When recording 1 channel: up to 960,000 readings/ch  
When recording 2 channels: up to 480,000 readings/ch  
When recording 3 channels: up to 320,000 readings/ch  
When recording 4 channels: up to 240,000 readings/ch                                                                 |
| Recording Mode                | Endless (Overwrite the most recent data when capacity is full) or One Time (Stop recording when capacity is full)                     |
| Recording Start Method        | Immediate Start or Programmed Start (by individual logger or by group)                                                               |
| Group Recording               | Up to 4 units (16 channels) can be recorded simultaneously. (Coupling of MCR-4TC and MCR-4V is possible. (*3))                         |
| Communication Interfaces      | USB Communication                                                                                                                     |
### Communication Time

Download Times for Full Data via USB
- From the master or a single unit: Approx. 1 minute 30 seconds
- From a slave unit: Approx. 4 minutes 30 seconds

### External Memory

SD Memory Card, SDHC Memory Card (*4) (For Manual or Automatic Data Export)

### Power

AA Alkaline Battery x 2 (AA Ni-MH batteries may also be used), USB Power (5V 250mA)

### Battery Life (*5)

<table>
<thead>
<tr>
<th>Rec.Method</th>
<th>Instantaneous Value</th>
<th>Average Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>100ms</td>
<td>Approx. 5 days</td>
<td>Approx. 5 days</td>
</tr>
<tr>
<td>500ms</td>
<td>Approx. 7 days</td>
<td>Approx. 7 days</td>
</tr>
<tr>
<td>1sec</td>
<td>Approx. 21 days</td>
<td>Approx. 7 days</td>
</tr>
<tr>
<td>5sec or longer</td>
<td>Approx. 60 days</td>
<td>Approx. 21 days</td>
</tr>
</tbody>
</table>

(Battery life for 1-channel measurement is about 1.4 times longer than that of 4-channel measurement.)

### Input Terminal

- **Screwless Terminals**
  - `<Compatible Wires>`
  - Single Wire: Ø0.32 to Ø0.65 mm (AWG 28 - 22)
  - Twisted Wire: 0.08 to 0.32 mm² (AWG 28 - 22), Ø0.12 mm or more in diameter
  - Stripping Length: 9 to 10 mm

### Isolation

- CH1, CH2, CH3, CH4, and USB are isolated. (Battery terminals are not isolated from the CH1-CH4 input terminals.)
- CH1-CH4 Maximum Applied Voltage: ±50 V
- Electrical Isolation Resistance: 50 MΩ or more (DC±250 V)

### Dimensions

H 120 mm x W 75 mm x D 32 mm

### Weight

Approx. 190 g (including batteries)

### Operating Environment

- Temperature: 0 to 50°C
- Humidity: 90%RH or less (no condensation)
## Software (MCR for Windows)

<table>
<thead>
<tr>
<th>Software</th>
<th>MCR for Windows</th>
</tr>
</thead>
</table>
| Compatible OS (*6) | "Microsoft Windows 8 32 / 64 bit (*7)  
Microsoft Windows 7 32 / 64 bit  
Microsoft Windows Vista 32 bit (SP1 or later)  
Microsoft Windows XP 32 bit (SP3 or later)" |
| Display Languages (*8) | English |
| Other | The .NET Framework 4 Client Profile is required. (*9) |

*1: MCR-4TC has superior noise filter, but the measurement may sometimes fluctuate due to strong noise. Especially when the recording interval is set to 200 ms or less, the filtering becomes weaker and hence the fluctuation may become greater.

*2: If the logging capacity is not filled at the end of one recording session, the logger can record up to 30 times.

*3: Group Recording may not be started depending on the recording or measurement interval specifications of the connected Master unit.

*4: Please check the T&D Website for information on memory cards whose operation has been confirmed.

*5: Battery life varies depending upon the ambient temperature, the recording interval, the number of measurement channels, and the frequency of data export to a memory card.

*6: For installation, it is necessary to have Administrator (Computer Administrator) rights.

*7: If you are using Windows 8, please note that our software is designed to be used in "Desktop" mode only.

*8: We recommend using an operating system in the same language as the display language. Operation in different languages is not guaranteed.

*9: During the installation process of the software, if not present, .NET Framework 4 Client Profile will be installed automatically.

The specifications listed above are subject to change without notice.
Product Support
For support, please contact the distributor from which you purchased the product.

**A list of distributors can be found at:**
http://www.tandd.com/about_tandd/contactus/

Product Information
Product information can be found at:
http://www.tandd.com/product/

---

**Multichannel Temperature Recorder MCR-4TC**

**User's Manual**

---

**T&D CORPORATION**
817-1 Shimadachi, Matsumoto, Nagano 390-0852, Japan
Website: http://www.tandd.com/
FAX: +81-263-40-3152       E-mail: support@tandd.com